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WYMOGI BEZPIECZEŃSTWA

Poniższe wymogi bezpieczeństwa nie zawierają wszystkich informacji dotyczących działania
urządzenia. Należy się zapoznać z niniejszą instrukcją obsługi w całości!

UWAGA: Wszelkich  podłączeń  i  zmian  należy  dokonywać  przy  odłączonym  napięciu
zasilającym.

UWAGA: Instalacja  oraz  programowanie  urządzenia  wymagają  posiadania  odpowiednich
umiejętności,  dlatego  mogą  być  dokonywane  tylko  przez  wykwalifikowany
personel po zapoznaniu się z całą instrukcją obsługi.

UWAGA: W przypadku,  gdy urządzenie  ulegnie uszkodzeniu,  należy  skontaktować się  ze
sprzedawcą lub osobą odpowiedzialną za instalację. 

UWAGA: Nieprawidłowo podłączone urządzenie może ulec uszkodzeniu.

UWAGA: Odpowiedzialność  za  prawidłową  instalację  urządzenia  spoczywa  na  osobie
montującej. Należy się upewnić czy spełnione zostają wszystkie wytyczne i normy
obowiązujące w danym kraju. 

UWAGA: Wyładowania  elektrostatyczne  mogą  uszkodzić  urządzenie.  Należy  stosować
odpowiednie zabezpieczenie.

UWAGA: Wszelkie nieautoryzowane przeróbki, modyfikacje oraz próby naprawy powodują
utratę gwarancji. 



Wstęp

Moduł MCT-1P służy do pomiaru temperatury w od 1 do 4 punktach, w zakresie -40ºC do +85ºC.
Rozdzielczość  pomiaru  temperatury wynosi  0.1ºC,  a  dokładność  pomiaru  maksymalnie  ±0.5ºC.
Średnia dokładność pomiaru jest mniejsza niż ±0.2ºC. Moduł może być zasilany napięciem od 9 do
24V prądu stałego (DC). Maksymalny pobór prądu wynosi 100mA. Wymiary modułu pozwalają na
zmieszczenie go w standardowej puszce instalacyjnej φ=60.

Rys. 1. Widok modułu MCT-1P

Dane techniczne

Tabela 1. Parametry graniczne

Nazwa parametru Uwagi Min. Max.

Napięcie zasilania
24VDC

Notka 1 35VDC

Temperatura Notka 1 -20ºC 90ºC

Napięcie na
wyprowadzeniach

SDA
-0.7VDC 6VDC

Notka 1: Przekroczenie parametrów granicznych może spowodować uszkodzenie urządzenia, lub/i
trwałe obniżenie parametrów. Długotrwała praca w warunkach bliskich parametrom granicznym
może spowodować nieprawidłowe działanie układu, a nawet uszkodzenie urządzenia.



Tabela 2. Rekomendowane warunki pracy

Nazwa parametru Uwagi Min. Typ. Max.

Napięcie zasilania
24VDC

9VDC 24V 32VDC

Prąd zasilania 24VDC 50mA 100mA

Napięcie na
wyprowadzeniach

SDA
0VDC 5.1VDC

Temperatura pracy -40ºC 80ºC

Wilgotność Notka 1 5% 95%

Wysokość 0m n.p.m. 2000m n.p.m.

Notka 1: Wilgotność bez kondensacji!

Instalacja

4.1. Obwód elektryczny

Schemat poglądowy modułu.



Rys. 2. Rozmieszczenie elementów na płytce modułu, dostępnej 
po odkręceniu dekielka

D1..D3 – diody LED sygnalizujące stan urządzenia
SW100 – przełącznik konfigurujący prędkość komunikacji, adres płytki oraz tryb Modbus

Uwaga: Podłączanie niezgodne z instrukcją może spowodować nieprawidłową pracę i/lub 
uszkodzenie urządzenia nie objęte gwarancją!



4.1.1. Złącze J1

Rys. 3. Widok konektora J1

Tabela 3. Opis wyprowadzeń na złączu J1 (złącze do podłączenia czujników):

4.1.2. Złącze J2

Rys. 4. Widok konektora zasilającego i komunikacyjnego J2

Tabela 4. Opis wyprowadzeń na złączu J2:

Numer
wyprowadzenia

Nazwa Opis

1 GND Minus zasilania modułu

2 +24VDC Plus zasilania modułu

3 D+ interfejs RS-485

4 D- interfejs RS-485

Numer 
wyprowadzenia

Nazwa Opis

1 NC Nieużywane

2 SDA Komunikacja z czujnikiem

3 GND Minus zasilania czujnika

4 +5V Plus zasilania czujnika



4.1.3. Diody sygnalizacyjne

D1(światło czerwone): Zasilanie CPU: miganie oznacza poprawną pracę urządzenia.

D2(światło zielone): Odbiór RS-485: miganie kontrolki oznacza odbieranie danych po RS-485.

D3(światło  czerwone): Nadawanie RS-485, miganie kontrolki oznacza wysyłanie danych 
                                           po RS-485.

Nieprzerwane świecenie  diod RX i TX sygnalizuje możliwość błędu w podłączeniu sygnałów  do 
gniazda. Miganie tylko diody sygnalizującej odbieranie danych przez moduł sygnalizuje 
możliwość wysyłania błędnego adresu, lub wybranie błędnych parametrów transmisji 
(nieprawidłowa prędkość, ustawienia parzystości, liczba bitów stopu, itp.)



4.2. Przykład podłączenia elektrycznego

Poniższy rysunek przedstawia schemat typowego podłączenia układu do magistrali RS-485. 
Moduł pomiaru temperatury można zasilać napięciem stałym z zakresu 9...24V. Do układu można
podłączyć  maksymalnie  4  czujniki  temperatury MCT-2 (dostępne  w naszej  ofercie).  Wszystkie
należy podłączyć do tych samych wyprowadzeń (tj. 2, 3, 4) w sposób widoczny poniżej. Połączenie
czujników do modułu najlepiej wykonywać kablem nieekranowanym.

Komunikacja modułu z innymi urządzeniami realizowana jest z wykorzystaniem interfejsu RS-485.
Przewody należy podłączyć według rysunku (rys. 5). Moduł może pracować tylko jako urządzenie
slave. Przełącznikiem SW100 ustala się adres fizyczny urządzenia, prędkość komunikacji oraz tryb
Modbus, co zostanie opisane w dalszej części instrukcji.

Rys. 5a. Przykład podłączenia czujników



Rys. 5b. Przykład podłączenia modułu pomiaru temperatury MCT-1P do sterownika

Czujniki  temperatury  MCT-2  są  dostępne  w  naszej  ofercie.  Czujnik  temperatury  MCT-2  jest
sprzedawany z 1-metrowym kablem.

Rys. 6. Czujnik temperatury MCT-2



4.3. Ustawianie prędkości, adresu i trybu Modbus

4.3.1. Ustawianie adresu Modbus za pomocą switcha SW100

Rys. 7. Switch SW100 do ustawiania adresu Modbus (zworki 1-6)
Na rysunku przedstawiono 31 z 63 możliwych ustawień adresu.

W położeniu przedstawionym na rysunku, zworka w pozycji OFF oznacza 0, w pozycji ON – 1. 

W switchu SW100 zworki 1..6 służą do ustawienia adresu w protokole Modbus:
1 – A0 (najmniej znaczący bit adresu - LSB),
2 – A1,
3 – A2,
4 – A3,
5 – A4,
6 – A5 (najbardziej znaczący bit adresu – MSB).

Adres modułu wyjść w protokole Modbus:
- ustala się sprzętowo za pomocą switcha SW100, 
- może przyjmować wartości 1..63, 
- adres 0 jest zarezerwowany w specyfikacji protokołu Modbus jako rozgłoszeniowy (broadcast), 
- ustawia się w postaci binarnej, tzn. 27 (dec) = 011011 (bin). Switch w pozycji ON to bit adresu
ustawiony jako 1. Switch w pozycji OFF to bit adresu ustawiony jako 0. 

Uwaga:  Aby  zmienić  adres  modułu  w  protokole  Modbus,  prędkość  transmisji  lub  tryb
RTU/ASCII,  należy  ustawić  żądane  parametry,  a  następnie  wyłączyć  i  włączyć  zasilanie.



Zmiana parametrów przy włączonym zasilaniu nie odniesie skutku. Nastąpi to dopiero przy
ponownym uruchomieniu urządzenia.



4.3.2. Ustawianie prędkości transmisji za pomocą switcha SW100.

Zworka 8 ze switcha SW100 służy do ustawiania prędkości transmisji:
OFF – prędkość 9600 bps
ON – prędkość 57600 bps

4.3.3. Ustawianie trybu Modbus (RTU/ASCII) za pomocą switcha SW100.

Zworka 7 ze switcha SW100 służy do ustawiania typu Modbus:
OFF – RTU
ON – ASCII

Uwaga:  W module  wyjść  i  urządzeniu  nim  sterującym  muszą  być  ustawione  takie  same
parametry transmisji!

Konfiguracja

5.1. Protokół transmisji danych

Moduł  komunikuje  się  z  urządzeniem  sterującym  za  pomocą  protokołu  Modbus.  W warstwie
fizycznej  połączenie  jest  realizowane  za  pomocą  interfejsu  RS-485  2W,  half-duplex  (z
przełączaniem  kierunku  transmisji).  Rejestry  1100..1103  są  rejestrami  3x  –  Input  Registers,
natomiast wszystkie pozostałe to Holding Registers – 4x.

      Tabela 5. Parametry transmisji w trybie RTU:
prędkość: 9600/57600 baud (przełączane zworką)
parzystość: Even
ilość bitów danych: 8
ilość bitów stopu: 1

      Tabela 6. Parametry transmisji w trybie ASCII:
prędkość: 9600/57600 baud (przełączane zworką)
parzystość: Even
ilość bitów danych: 7
ilość bitów stopu: 1

      Tabela 7. Rejestry Modbus i ich znaczenie w czujniku temperatury:
Numer rejestru Nazwa Opis

1100 Identyfikacja Rejestr do identyfikacji

1101 Ilość czujników Ilość czujników temperatury
podłączonych do modułu

1102 Wersja FW Wersja firmware modułu

1103 Stan przełącznika SW100

1200 Znak 1 Dodatnia temperatura

1201 Część całkowita temperatury 1 Część całkowita

1202 Część ułamkowa temperatury 1 Część ułamkowa



1203 Znak 2 Ujemna temperatura

1204 Część całkowita temperatury 2 Część całkowita

1205 Część ułamkowa temperatury 2 Część ułamkowa

1206 Znak 3 Dodatnia temperatura

1207 Część całkowita temperatury 3 Część całkowita

1208 Część ułamkowa temperatury 3 Część ułamkowa

1209 Znak 4 Ujemna temperatura

1210 Część całkowita temperatury 4 Część całkowita

1211 Część ułamkowa temperatury 4 Część ułamkowa

1212 Czas pomiędzy odczytami Odczyt co 1s

1213 Błąd Pojawienie się wartości innej
niż 0 sygnalizuje błąd.

1214 Ilość wykrytych czujników Wykryto cztery czujniki

1215

Numer seryjny czujnika 1

MSB

1216

1217

1218 LSB

1219

Numer seryjny czujnika 2

MSB

1220

1221

1222 LSB

1223

Numer seryjny czujnika 3

MSB

1224

1225

1226 LSB

1227

Numer seryjny czujnika 4

MSB

1228

1229

1230 LSB

1231 Znacznik programowania 
konfiguracji

170



Przykład:
Adres 1100: 109  Numer identyfikacyjny

Adres 1101: 4 Wykryto 4 termometry

Adres 1102: 222 Wersja oprogramowania 2.2.2

Adres 1103: 1 Wartość ustawiona na przełączniku

Adres 1200: 0 Dodatnia temperatura czujnika 1

Adres 1201: 21 Część całkowita czujnika 1 

Adres 1202: 2 Część ułamkowa czujnika 1

Adres 1203: 1 Ujemna temperatura czujnika 2

Adres 1204: 25 Część całkowita czujnika 2 

Adres 1205: 9 Część ułamkowa czujnika 2

Adres 1206: 0 Dodatnia temperatura czujnika 3

Adres 1207: 7 Część całkowita czujnika 3 

Adres 1208: 2 Część ułamkowa czujnika 3

Adres 1209: 1 Ujemna temperatura czujnika 4

Adres 1210: 0 Część całkowita czujnika 4 

Adres 1211: 2 Część ułamkowa czujnika 4

Adres 1212: 2 Odczyt temperatury co 2s

Adres 1213: 0 Brak błędów

Adres 1214: 4 Wykryto 4 czujniki

Adres 1215: 0123h (h - szesnastkowo) Numer seryjny 1 czujnika

Adres 1216: 4567h Numer seryjny 1 czujnika cd

Adres 1217: 89ABh Numer seryjny 1 czujnika cd

Adres 1218: CDEFh Numer seryjny 1 czujnika cd

Adres 1219: 1234h Numer seryjny 2 czujnika

Adres 1220: 5678h Numer seryjny 2 czujnika cd

Adres 1221: 9ABCh Numer seryjny 2 czujnika cd

Adres 1222: DEF0h Numer seryjny 2 czujnika cd

Adres 1223: 2345h Numer seryjny 3 czujnika

Adres 1224: 6789h Numer seryjny 3 czujnika cd

Adres 1225: ABCDh Numer seryjny 3 czujnika cd

Adres 1226: EF01h Numer seryjny 3 czujnika cd

Adres 1227: 3456h Numer seryjny 4 czujnika

Adres 1228: 789Ah Numer seryjny 4 czujnika cd

Adres 1229: BCDEh Numer seryjny 4 czujnika cd

Adres 1230: F012h Numer seryjny 4 czujnika cd

Adres 1231:  0 Adres do przypisania czujników

Moduł pomiaru temperatury (109), podłączone 4 czujniki, wersja firmware 2.2.2;
temperatura odczytana z czujnika 1: +21,2ºC, z czujnika 2: -25,9ºC, z czujnika



3: +7,2ºC, z czujnika 4: -0,2ºC, pomiar temperatury co 2s, brak błędów, wykryto
4  czujniki,  numer  seryjny  1  czujnika:  0x0123456789ABCDEF,  numer  seryjny  2
czujnika:  0x123456789ABCDEF0,  numer  seryjny  3  czujnika:  0x23456789ABCDEF01,
numer seryjny 4 czujnika: 0x3456789ABCDEF012.

Uwaga:  Podane numery seryjne nie  są rzeczywistymi  numerami seryjnymi czujników - zostały
pokazane jedynie jako przykład.

5.2 Konfigurowanie modułu do współpracy z czujnikami

Czujniki DS18B20 posiadają unikalne numery seryjne, po których są rozpoznawane przez moduł
pomiaru temperatury.  Numery te nie są umieszczone na  obudowach czujników, więc nie da się
połączyć konkretnego czujnika z jego numerem w module. Dodatkowo, w przypadku gdyby np.
jeden  z  czujników  przestał  działać,  wtedy   po  następnym  uruchomieniu  urządzenia  inny
z czujników (o numerze seryjnym niższym niż ten uszkodzony) przejmie jego rejestry w module.
Może  to  spowodować  niespodziewane   efekty,  gdy  czujnik  mierzący  temperaturę  w  piwnicy
zostanie przypisany do salonu. 

Aby zapobiec takim sytuacjom, od wersji 2.0.4 modułu pomiaru temperatury został wprowadzony
tryb programowania konfiguracji. Po podłączeniu wszystkich czujników do modułu i uruchomieniu
komunikacji  po  Modbusie  do  rejestru  1231  ("Znacznik  programowania  konfiguracji"),  należy
wpisać  wartość  0xAA,  czyli  170  dziesiętnie.  Ta  operacja  powoduje  zapisanie  konfiguracji
czujników w wewnętrznej pamięci modułu. Gdy potem czujnik ulegnie uszkodzeniu – tak, że nie
będzie  rozpoznawany  przez  moduł,  nie  spowoduje  to  przesunięcia  się  pozostałych  czujników
w tabeli modułu. Natomiast w rejestrach uszkodzonego czujnika pojawi się wartość 255,255,255,
co  oznacza  błąd  odczytu.  Ponieważ  prawidłowe wartości  rejestru  „Znak”  to  0  lub  1,  program
użytkownika  może  łatwo  wykryć  błąd.  Po wymianie  czujnika  należy ponownie  przeprowadzić
proces programowania konfiguracji. 

Uwaga: Ilość  dopuszczalnych  cykli  programowania  konfiguracji  jest  ograniczona,  dlatego  po
każdej  wymianie  czujnika  można  programować  konfigurację  tylko  raz.  W  szczególności
niedopuszczalne  jest  dodawanie  programowania  konfiguracji  do  normalnej  tabeli  Modbusa
używanej  do  komunikacji  w  systemie.  Spowoduje  to  wyczerpanie  dopuszczalnej  ilości  cykli
programowania i uszkodzenie urządzenia w czasie krótszym niż 7 minut.

Od wersji oprogramowania modułu 2.2.2 istnieje dodatkowy sposób przypisywania czujników.
Polega  on  na  sprzętowej  zmianie  wartości  przełącznika  SW100.  Aby  wykorzystać  ten  sposób
należy podłączyć czujniki temperatury do modułu a następnie zmienić pozycję dowolnego pinu w
przełączniku SW100 i po ok 1s wrócić do poprzedniego położenia. 



5.3. Przykład podłączenia modułu pomiaru temperatury do sterownika PLC 
Fatek

Aby nawiązać komunikację z modułem poprzez port RS-485, należy najpierw skonfigurować port
w sterowniku PLC. Możemy tego dokonać za pomocą programu  WinProLadder.

Wybieramy  z  menu  PLC  →  Setting  →  Port  (numer  portu,  po  którym  będzie  odbywała  się
komunikacja) 

Rys. 8. Wybór portu komunikacyjnego w sterowniku PLC

Po wybraniu  odpowiedniego  portu  następnie  musimy go skonfigurować.  Ustawiamy parametry
transmisji w trybie RTU:

1.) prędkość (Baud Rate): 9600/57600 (ustawiane zworką) 
2.) parzystość (Parity) even
3.) ilość bitów danych (Data Bit): 8
4.) ilość bitów stopu: (Stop Bit) 1
5.) protokół Modbus RTU (slave)



Rys. 9. Konfiguracja portu komunikacyjnego sterownika PLC, w trybie RTU

Po wybraniu odpowiedniego portu musimy go skonfigurować.  Ustawiamy parametry transmisji
w trybie ASCII:

1. prędkość (Baud Rate): 9600/57600 (ustawiane zworką) 
2. parzystość (Parity) even
3. ilość bitów danych (Data Bit): 7
4. ilość bitów stopu: (Stop Bit) 1
5. protokół Modbus ASCII (slave)



Rys. 10. Konfiguracja portu komunikacyjnego sterownika PLC, w trybie ASCII
Sterownik  ustawiony  jako  „master”  musi  mieć  uruchomioną  funkcję  M_BUS  (funkcja  150).
W funkcji  150.M_BUS użytkownik  ustawia  tylko port,  którego będzie  używał  do komunikacji,
rejestr startowy programu do komunikacji oraz rejestr roboczy. 

Funkcja 150.M_BUS

Rys. 11. Symbol funkcji M_BUS

Pt: Numer portu, który ma być użyty do komunikacji
SR: Rejestr startowy 
WR: Rejestr roboczy 
Jeżeli wejście A/R = 0   - protokół Modbus
Jeżeli wejście A/R = 1   - protokół Modbus ASCII
Jeżeli wejście ABT zmieni się na 1, operacja zostaje przerwana i po jej wznowieniu przesyłanie
zaczyna się od pierwszego pakietu danych.



Kiedy już zostanie skonfigurowany port oraz wstawiona funkcja 150.M_BUS,  musimy stworzyć
tabelę. Z menu wybieramy Project → Modbus Master Table → Add Modbus Master Table.

Rys. 12. Widok ekranu przy wstawianiu z menu tabeli do obsługi Modbusa w programie
WinProladder.

Rys. 13. Widok ekranu przy wstawianiu z drzewa konfiguracji tabeli do obsługi Modbusa 
w programie WinProladder.

Po wybraniu Add Modbus Master Table pojawi się okno Table Edit. 



Rys. 14. Okno konfiguracji funkcji Modbus w sterowniku PLC.

W polu  Table  Name  użytkownik  może  wpisać  dowolną  nazwę  np.  Modbus,  natomiast
w polu  Table  starting  address  należy  wpisać  rejestr  startowy,  który  został  użyty  w  programie
w funkcji 150.M_BUS, np.: R1000. Następnie po pojawieniu się okna Modbus Master Table można
dodawać komendy. 

Rys. 15. Okno edycji komend w komunikacji Modbus

Po naciśnięciu przycisku Add pojawia się okienko „Command Item”, w którym należy wprowadzić
numer stacji Slave Station (adres naszego czujnika) inny niż numer stacji „master”, na której używa
się  funkcji  M_BUS.  Następnie  wybrać  rodzaj  komendy,  rozmiar  przesyłanych  danych,  adres
startowy w sterowniku „master” oraz adres startowy w czujniku (lub innym urządzeniu) „slave”.



Przykładowa konfiguracja (odczyt temperatury):
Slave Station: 2 (adres fizyczny modułu równy 2)
Command: Read
Data Size: 12 (4 czujniki)
Master Data Start Address: np.: R400 (odczytuje wartości z modułu do tych rejestrów)
Slave Data Start Address: np.: 401200 

Przykładowa konfiguracja (zmiana czasu odczytu):
Slave Station: 2 (adres fizyczny modułu równy 2)
Command: Write
Data Size: 1 
Master Data Start Address: np.: R412 (zapisuje wartości z modułu do tych rejestrów)
Slave Data Start Address: np.: 401212 

Przykładowa konfiguracja (odczyt błędu i ilości czujników):
Slave Station: 2 (adres fizyczny modułu równy 2)
Command: Read
Data Size: 2 
Master Data Start Address: np.: R413 (odczytuje wartości z modułu do tych rejestrów)
Slave Data Start Address: np.: 401213 

5.4. Przykład podłączenia modułu pomiaru temperatury do panelu HMI

Aby nawiązać komunikację z modułem poprzez port RS-485, należy najpierw skonfigurować port
w panelu HMI. Możemy tego dokonać za pomocą programu  „EasyBuilder  8000”. Wybieramy
z menu Edit → System Parameters….



Rys. 16. Okno do dodawania urządzeń podłączanych do panelu HMI

Następnie klikamy na „New…”, w efekcie czego pojawi się okno jak na rysunku poniżej:

Rys.17. Okno do edycji parametrów komunikacji

Możemy teraz ustawić parametry komunikacyjne urządzenia. Chcąc komunikować się po Modbus
należy w danych polach wybrać:

PLC type - typ komunikacji: MODBUS RTU



PLC I/F - typ portu, po którym będzie odbywać
się komunikacja:

RS-485 2W

PLC default station no.
adres sprzętowy 

modułu temperatury

COM
numer i ustawienia portu, przez który odbywa

się komunikacja panelu HMI z modułem.

Aby ustawić te parametry, należy kliknąć na pole Settings… i wybrać odpowiednie wartości:

1. COM (numer portu komunikacyjnego): COM 1
2. Baud rate (prędkość komunikacji): 57600 
3. Data bits (ilość bitów danych) 8 Bits
4. Parity (parzystość): Even
5. Stop bits (ilość bitów stopu): 1 Bit

Rys.18. Ustawienia portu komunikacyjnego

Przykładowa konfiguracja:

A) Odczyt temperatury: część całkowita

Aby odczytywać żądaną wartość z modułu, należy utworzyć odpowiedni obiekt w panelu HMI,
wyświetlający tę wartość. 

W tym celu wybieramy: menu Objects → Numeric/ASCII → Numeric Display



Rys. 19. Tworzenie obiektu Numeric Display

Pojawi  się  okno  Numeric  Display  Object’s  Properties,  w  którym w  celu  odczytu  temperatury
należy:

W zakładce „General” wybrać:
 Description (własny opis obiektu)
 PLC name: MODBUS RTU
 Device type: 4x
 Address (numer rejestru, który chcemy odczytać): 1204

(1204 dla temperatury)

Rys. 20. Właściwości obiektu Numeric Display

W zakładce „Numeric Format” należy wybrać:
1. Data Format: 32-bit Float
2. Mask: Odznaczyć
3. Left of decimal Pt: 3  (część całkowita)
4. Right of decimal Pt: 4  (część ułamkowa)



Rys. 21. Właściwości obiektu Numeric Display

Po zatwierdzeniu ustawień możemy ulokować obiekt w dowolnym miejscu przestrzeni roboczej
programu  EasyBuilder.  Po  załadowaniu  programu  do  panelu  HMI  można  już  odczytywać
temperaturę. 

W celu zmiany czasu próbkowania należy wykonać tę samą procedurę co powyżej, z tą różnicą, że
nie  wybieramy już  obiektu  wyświetlającego  dane,  tylko  obiekt  odpowiedzialny za  wpisywanie
danych, czyli „Numeric Input”. W skrócie:

W zakładce „General” wybrać:
Description (własny opis obiektu)
PLC name: MODBUS RTU
Device type: 4x
Address (numer rejestru przechowujący czas między odczytem): 1203



Rys. 22. Właściwości obiektu Numeric Display
W zakładce„Numeric Format” należy wybrać:
Data Format: 16-bit Unsigned
Mask: Odznaczyć
Left of decimal Pt: 3 
Right of decimal Pt: 0 

Rys. 23. Właściwości obiektu Numeric Display

Po zatwierdzeniu ustawień możemy ulokować obiekt w dowolnym miejscu przestrzeni roboczej
programu EasyBuilder.  Po załadowaniu programu do panelu HMI można już odczytywać część
całkowitą temperatury z czujnika numer 1.

B) W celu wyświetlenia innej wartości mierzonej przez moduł należy powtórzyć całą tę procedurę,



zmieniając tylko numer rejestru odpowiedzialnego za daną wielkość z modułu. Na przykład
chcąc sprawdzić, czy wystąpił błąd podczas pomiaru, należy w polu „Address” wpisać wartość
1213.

C) W celu zmiany czasu próbkowania należy wykonać tę samą procedurę co powyżej, z tą różnicą,
że  nie  wybieramy  już  obiektu  wyświetlającego  dane,  tylko  obiekt  odpowiedzialny  za
wpisywanie danych, czyli „Numeric Input”.



5.5. Wymiary modułu pomiaru temperatury MCT-1P

Na rysunku  poniżej  pokazano  wymiary  obudowy modułu  pomiaru  temperatury.  Obudowa  jest
przystosowana do montażu w puszce elektroinstalacyjnej φ 60.

Rys. 24. Wymiary obudowy

Uwagi końcowe

1. Producent zastrzega sobie prawo do wprowadzania ciągłych poprawek i ulepszeń.
2. Produkt może nieznacznie różnić się od fotografii.
3. Instrukcja może zawierać błędy. Producent nie odpowiada za jakiekolwiek uszkodzenia, które    

mogą z  nich wyniknąć.  Jednocześnie producent  oświadcza,  że dołoży wszelkich starań,  by  
żadne błędy w instrukcji się nie pojawiły,  a jeżeli tak się stanie, to informacje o wszelkich  
błędach zamieści na swojej stronie internetowej. 

4. Producent nie odpowiada za żadne szkody wynikające z użytkowania urządzenia.
5. Aktualna wersja instrukcji znajduje się na stronie www.  e-tronix.eu .
6. Wszelkie uwagi dotyczące urządzenia oraz tej instrukcji oraz pytania w sprawach technicznych 

nie wyjaśnionych wyżej proszę kierować na e-mail: e-tronix@e-tronix.eu.

http://www.esea.pl/
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